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Introduction  
This manual should serve as one of the primary tools for installation and operation of the Capture software. 
Capture Sweden’s e-mail support, online web forum and YouTube channel are all available as important 
complements to this manual.

Please visit our website http://www.capture.se for regular software updates and important product 
information. Also make sure to notify us if your e-mail address is changed, since e-mail is our primary 
communication channel.

System Requirements  

Capture 2019 for Windows requires a 64-bit installation of Windows 10. Capture may run on older versions of 
Windows, but these are not officially supported.

Capture 2019 for macOS requires macOS 10.13 or higher and Metal support. Please refer to Apple's HT205073 
article https://support.apple.com/en-us/HT205073 "Mac computers computers that support Metal" for more 
information about Metal compatibility.

Installation  

Capture installation packages for Windows and macOS can be downloaded from our website http://www.capt
ure.se. The installation packages contain a copy of the latest library at the time the installation package was 
built. The latest library, which is updated on a daily basis, can be downloaded separately at any point.

Windows Installation  

Capture is distributed with a Microsoft Installer (.msi) package for Windows. Once you have downloaded the 
installation package, double click it to launch the installation.

macOS Installation  

Capture is distributed as an “.app” package inside a .DMG (Disk Image) for macOS. Once you have 
downloaded the installation package, double click on it to mount the disk image and drag and drop the 
application to your Applications folder as illustrated in the window that appears.

Licence Installation  

Capture licences are contained and distributed as licence key files and licence key file tickets. Capture licenses 
are personal and the same licence key file can be installed on multiple computers. Once a licence key file has 
been installed on a new computer it must also be unlocked before it can be used.
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Licence key files are obtained using licence key file tickets and installed from within Capture in the Licensing 
dialog, accessible from the Welcome window on startup as well as from the Tools menu. 

Once a licence key file has been installed and the licence information has appeared in the dialog, choose 
either Automated unlock or Manual unlock in order to unlock it. The automated option connects over the 
Internet and allows immediate unlocking as long as the licence has not been unlocked on too many 
computers. The manual option allows you to send the unlock request to us by e-mail to unlock@capture.se 
and may take some time as it requires manual attention from our support staff, but we will help you as 
promptly as possible.

Library Updates  

Library updates are available on our website http://www.capture.se and are updated on a daily basis. If you 
have requested library additions and we have notified you that a new library package is available this is where 
you would obtain it.

Library packages are installed from within Capture, using the Upgrade library command in the Tools menu. 
Note that library packages are not compatible across releases.

Support  

Support to our customers is offered through e-mail and our online web forum at http://www.capture.se. 
Under extraordinary circumstances we may also communicate with you over telephone, Skype or other 
communication services.

Use support@capture.se for technical support.

Use library@capture.se for questions regarding the library or if you are missing fixtures.

For fastest possible assistance, please e-mail us using the address your licence is registered on.
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Software Overview  
On startup the Welcome dialog is shown with shortcuts to open recently opened project files and the Capture 
news feed. Once this has been closed, the main Capture interface remains.

The main components of the interface highlighted in the image are:

1. Main menu.
2. Design views (three in total).
3. Project window.
4. Navigator selection interface.
5. Navigator view interface.

Main Menu  

The main menu is available at the top of the main window.
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In the File menu you will find the basic commands for opening, saving and closing Capture project files. 
Note the variety of different options are available for opening older Capture project files.

The Import Model feature is used to open up other project files in parallel and allows you to copy items from 
other projects into the project you are working with (which is done using the arrow navigator button).

The Import Data feature allows you to import a variety of drawing formats from other programs, as well as 
specific project data such as fixture patch, weight, etc.

The Import Project Content feature allows you to import layers, filters, reports, plot styles and plots from 
another project.

The Export Presentation feature that allows you to create an executable file that will launch your project, 
which is embedded in the executable file, and show the Alpha view. Presentations cannot be used to edit 
project files, they merely serve as a viewing and presentation tool.

The Export for Capture Nexum, Atlas, Argo functions allow you to export your project to older versions of 
Capture.

The Export focus sheets feature creates a set of images, one per fixture (or as configured in the 
configuration dialog presented), giving you a view out through the aperture of the fixture. It requires you to 
pick a folder into which the images are placed.

In the Edit menu you will find access to the unlimited Undo and Redo commands.



The Tools menu gives you access to the Options window and the Translation window.

Design Views  

Capture has three design views, Alpha, Beta and Gamma. These views can be configured to the users liking. 
Configuring a design view is done by clicking on the green list button as shown below.
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Command Description

Wireframe
Wireframe is the default view and works as a 3D CAD wireframe view whereby a
user can orbit any object in 3D but it is only rendered in wireframe.

Plot
Replaces the Paper view from previous Capture versions. This view is used to
make plots.

Live Live 3D rendering view.

Custom
In Custom mode, you can configure your own look view with either
wireframe/solid, perspective/orthographic etc.

Camera
Camera shows a list of preset camera positions for quick navigation, as well as
the ability to launch one of the user made camera positions.

Store Camera
By positioning the camera to a user defined location, a user can then go to the
Store camera option and choose a camera preset to store the current camera
pose to.

Grid Grid toggles the grid on/off for the selected view.

Widgets Widgets (such as the camera) can be toggled on/off for the selected view.

Hidden Objects Hidden objects can be toggled on/off for the selected view.

Project Information Toggles the project information on/off for the selected view.

Fixture Information
Fixture information replaces the previous Live Information option from Capture
Argo. It overlays fixtures with programming information like shutter and color
mix status.

Quality Information Toggles the FPS and quality info on/off for the selected view.

Save Image.. Save an image of the currently selected view.

Some view settings are not available in the navigator. Additional settings for each view are available in the 
Design tab of the Project window. With the Views category selected, each view has one column of 
properties appear on the right hand side.



The Grid width and Grid height properties determine the distance between grid lines.

The Vertical field of view property lets you control lens angle of the view’s camera.

The Aspect ratio of a view can be set to follow 4:3 as well as 16:9.

The Brightness, Exposure and Atmosphere settings controls the look of the view when in Live mode. If you 
have enabled the “Simpler Graphics” option of Capture, Brightness and Exposure are replaced with Fixture 
Lighting and Fixture Lighting Differentiation.

DMX Control  

It is possible to control a view using DMX. This is achieved by either manually assigning a Patch universe / 
channel or by dragging the view’s camera from a design view to a channel in a Universe view. The Patch 
mode option can be used to select the number of channels used by the camera. See Append A for details on 
the DMX channel layout.

Project Window  
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The Project Window is the main information area in Capture. It hosts the properties for the selected items, 
additional settings for the Alpha, Beta and Gamma Views, settings for Layers and Filters, Scenes, Materials, 
Custom Gobo wheels, Custom Frame (color) lists, Reports Plot styles and Plots. Furthermore, the window is 
split into a navigation list down the side with the properties for whatever is selected from that list available on 
the right. Along the top are some tabs - Design, Fixtures, Universes, Media, Snapshots and Library. Generally 
speaking, to add an object of any type to a capture project, it needs to be dragged from the library tab to one 
of the design views. Objects can only currently be dragged into a wireframe or plot view.

Navigator  

The Navigator is one of the main tools of capture. It is used for two primary functions - Navigation and 
Manipulation.

The navigation part of the Navigator is present in the bottom right corner of the Alpha, Beta and Gamma 
views. This Navigator is used to manipulate the view in terms of changing the camera viewing point and zoom 
within the view as well as accessing the view settings via the spanner button.

The First button, a curve with arrows, allows you to move around a view. Holding the Shift or Ctrl keys allows a 
different style of movement in the 3D views.
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The second button is used to zoom in and out on the selected view. Holding the button and moving the 
mouse up or down will control the amount the camera is zoomed in or out.

The third button is used to access the settings for the selected view as we discussed earlier. Additional 
settings for each are available in the Design tab of the Project window.

Whenever you select any objects, within any of the Alpha, Beta or Gamma views within Capture; a second type 
navigator appears. When objects are selected, they appear red with a a red grid around them that has some 
control buttons below it. This second type of navigator is used to assist in the manipulation of the objects.

Objects can be selected by clicking on them with the mouse. Use the Shift key to add objects to the selection 
and the Ctrl key to toggle individual object selection on and off. By click-dragging the mouse over a group of 
objects, you can select them all at a time. If you drag from the left to the right, the objects must lie completely 
within the region, but if you drag from the right to the left, it is enough for the objects to be partially inside the 
region in order to become selected.

Clicking and moving the mouse anywhere inside the Translation grip allows you to move objects around. This 
area is intentionally large so that it is easy to move items. While moving items, you can enable the ortho mode 
by pressing Shift key. Snapping in the sense of bringing items to a minimal distance is built in and activated 
during any translation, but is not triggered until after a short delay. When snapping is activate, the result of 
the snapping is illustrated with an alternate colour.

Clicking and moving the mouse inside a Distribution grip will allow you to spread out or bring together the 
selected objects over the given area in a proportional manner. The ortho mode is available here by using the 
Shift key as well. The Rotation anchor is used to rotate objects. It can be moved around to define the center of 
rotation and allows for both Individual rotation and Group rotation. Pressing the Shift key enables snapped 
rotation.



The first button is the selection menu button. It allows you to select or deselect everything, with the added 
“layer” option. Using the “layer” option will allow you to select or deselect everything but only in the current 
layer. Layers will be discussed in a later chapter.

The second button is the actions menu button. It displays a small list of possible operations relevant to the 
selected object(s). The list that appears is context sensitive, that is to say that selecting a Lighting Fixture will 
display different options in the list than that of a Truss. Each available option/command will be covered later 
in the relevant chapters.

The arrow button is used to drag objects out of one view to another. Using this button, the objects won’t 
actually move per say. The button is used primarily for patching fixtures. Select multiple fixtures in the order 
you wish to patch them and use the drag button to drag them onto a universe in the project window or on an 
open universe window. This functionality will be covered later in the relevant section.

You may also use the arrow button to drag the object to a new location in the same window, thereby making a 
copy.

The button with a list is the Quick Summery button. Pressing it when you have objects selected presents a 
popup window about the selected objects displaying key data about them. This button reveals the fixture 
control pane and is only visible when at least one lighting fixture is selected and the view is in Live mode.

Smoke Settings  

Smoke is added to and managed using smoke boxes. New projects contain one auto sizing smoke box by 
default. The presence of a smoke boxes is indicated by a cloud widget and when selected its extents become 
visible. Smoke boxes can be deleted as any other object and more smoke boxes can be added from the 
Library tab at any time.

To adjust the properties of a smoke box, select it and edit its properties in the Selected Items category in the 
Design tab.

Control the overall amount of smoke in a smoke box using the Density property. You can also adjust the 
Variation from perfect haze to puffy clouds. Edge softness adds a soft edge to smoke boxes.

Smoke boxes are animated in real-time and the speed of the animation is controlled through the Speed 
property. This property is shared by all smoke boxes.

Typical applications of more than one smoke box include denser smoke on stage in an arena with otherwise 
thin haze as well as localized fog situations such as heavy fog or fog behind a glass.

Limiting smoke to the area around the stage also helps avoid problems with beams shot into the audience 
oversaturating the visualisation. The Smoke element is in a new project by default (much like the camera 
object).

Smoke can also be patched to DMX. A smoke box can be patched by drag and dropping it in a DMX universe 
view like any fixture, or by assigning an address to the Patch property in the Design tab. See Appendix A for 
details on the DMX channel layout.

Rendering Settings  
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The rendering settings (previously visualization settings, under software options) is a tab within the project 
window. Its properties control the rendering quality of the live design views.

The Multiple Apertures visualization option controls the rendering of multi-aperture (striplights, BB-7, 
multi-LED moving heads) beams. In simple mode, only a single beam is rendered using the fixtures average 
color.In realistic mode each aperture renders a beam of its own. In Automatic mode a single beam is rendered 
for the fixture when all apertures have the same color.

The Beam Atmospheric Detail option allows you to control the level of detail created by a beam passing 
through the smoke/haze in the atmosphere.

The Beam shadow resolution option allows you to lower the resolution of shadows created by beams.

The Automatic Quality option allows you to turn on/off the automatic quality functionality Capture uses. 
Having automatic quality turned on will allow capture to be more efficient while rendering more complex 
scenes by sacrificing quality to keep good performance.

The Resolution Scaling option allows you to render live visualization at a lower resolution than the screen.

The Atmospheric Resolution option controls the resolution of atmospheric visualization, (Smoke). The Beam 
Atmospheric Details option allows you to control the level of detail created by a beam passing through the 
smoke/haze in the atmosphere. Higher levels of Beam Atmospheric Detail are relevant when using many wide 
angle beams and/or shooting through scenery that intersects beams.

The Beam Shadow Resolution option allows you to increase the resolution of shadows created by beams 
when shooting over long distances or on/through scenery.

The Spill Lighting option enables the visualization of a beam contribution beyond a fixtures field angle.

The Frosted Transparents option allows you to disable the visualization of the frosted effect of transparent 
materials.
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Software Options  

The software options are available through the Tools menu Options command and are split in two 
categories.
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General Options Tab  

Here you can change the language of the user interface in Capture. By default it will follow the settings of your 
computer.

The Ignore C: drive options is important on Microsoft Windows machines that have their Windows 
installation on a drive other then C : \

Turning on the Live updating transformation option causes all simulation views to update at once when 
moving or rotating objects.

Locking layers is a useful way of preventing accidental modification of fixed items such as the house of your 
venue. The Locked layers unselectable option takes it one step further and prevents you from even 
selecting such items.

The Show navigator on external selection is a feature for users with controllers that are capable of 
selecting fixtures. Unless this option is enabled, fixtures selected from a controller will only highlight as red 
and not display the navigator with the command buttons.

Free-flight navigation is normally accessible using the Shift key when navigating but can be set as the default 
behaviour instead (in which case the Shift key can be used to access orbit navigation).

The size of the navigator’s rotation anchor can be changed with the Rotation anchor angle and Rotation 
anchor length options. The rotation anchor snapping angle can be set with the Rotation snap angle option.

Connectivity Options Tab  

This tab contains options for controller and media server connectivity. It can be important to set the Preferred 
network address on a machine with multiple network addresses, but unless you are connecting to older 
equipment it is not encouraged to enable the Compatible CITP mode as it may make it impossible to connect 
to newer equipment.

You may also alter the incoming video format for CITP communication.

By default, Art-Net, sACN (E1.31), Compulite VC, ETC Net 2, HippoMap (HMap3), Lan Box, Lasergraph DSP and 
PangolinLD are all set to Automatic. On rare occasions when a machine has more than one network adapter, 
it may be necessary to change Automatic to a specific IP address available under the relevant protocol.
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Object Manipulation  
Any physical thing in a Capture project file is an object, whether it be a Lighting Fixture, piece of stage deck, 
LED screen, table or chair - is irrelevant. They are all treated the same in respect to adding them to the project, 
moving them around, cloning (copying) them, deleting them and accessing their properties.

To explore more about object manipulation, start a new Capture Project. Do this by going to the main menu in 
the top left corner and pressing New.

Leave the Alpha and Beta views with their default settings. Change the Gamma view to the Live mode by 
clicking on the green list button and selecting Live. Your windows should look the same as the image below.

Adding Objects  

Now we have a clean project file, we can proceed to add some objects to it.

To add an object to the project, we must first locate it from the Library. The Library tab in the Project 
Window is where all objects can be located. We want to add a stage floor.

Navigate to the Library, click on Objects, then again on Forms. Click on the Box form and drag it into either 
the Alpha or Beta view. Your project should look something like the image below.
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We can now proceed to changing the properties of the box so that it looks more like a stage floor. You may 
select the box by simply clicking on it in any of the views. The red navigator will appear around the box. Press 
the red spanner button to present the options available for the box.

Click the Properties option. This will toggle the project window to the Design tab with the Selected Items 
section already active showing the properties for the box.

Change the box dimensions to a width of 12m, height of 0.1m and a depth of 8m. Your Properties should look 
like the image below.



The end result will be the box looking a lot more like a floor.

Now we have a stage floor in place we can proceed to add some more objects. We will add some truss in 
above the stage. Adding a piece of truss is done in the same way the box was added. Locate the desired piece 
in the library and drag it into either the Alpha are Beta view. For the sake of example, we will use a piece of 
truss from the Generic folder. Double click the Truss folder, double click again on the Generic  folder, and 
again on Box. Choose the Generic Rectangular Section and drag it into one of the views.



The Truss is 2m wide. We know that the stage floor is 12m wide. We now want to add more 2m sections of 
truss to result in one long truss going from one side of the stage to the other. This can easily be done with the 
Clone feature.

Click on the truss piece to select it. Press the red spanner button to access the available options for the truss.

Click the Clone option, this will bring up the Clone window. Set the X Offset to 2m and set the number of 
clones to 5. This will then add sections of 2m truss right across our 12m wide stage evenly.

Currently, they still act as 6 separate pieces of truss. Select the pieces and press the red spanner button again. 
Choose the Group option and now the 6 sections are grouped together. They can now be moved and 
manipulated all as one.

Navigator commands  

The navigator's actions menu contains a number of commands that can be used to manipulate the currently 
selected objects.

Transform  
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This command allows you to move or rotate by an exact distance or amount of degrees. Use the green 
navigator cube to guide you with the X, Y and Z directions in the current view. Note that the rotation angle 
takes the placement of the rotation anchor into account and always performs a Group rotation.

Align  

The Align option allows you to select a group of objects and quickly align them a long a specific axis very 
quickly. Whatever align function is used is always relevant to the design view you are using it in. The options 
available are displayed to the right.

Spread Even  

The Spread Even function allows you to select a group of objects or fixtures and spread them evenly along a 
vertical or horizontal axis very quickly. It is extremely useful for making lines of objects very quickly.

Clone  

This command allows you to create one or more copies of the object or group of objects you have selected. 
Use the green navigator cube to guide you with the X, Y and Z directions in the current view. The offset values 
are applied incrementally which means that if you specify two copies with an offset of 2m, the first copy will 
be created 2m away from the original and the second copy will be created 4m away from the original etc. 
Note that the rotation angle takes the placement of the rotation anchor into account.
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For instance you can create a circle of ten boxes by selecting a box, moving the rotation anchor of the circle, 
choosing the Clone command, entering an angle of 36 degrees (a full circle of 360 degrees split in ten objects) 
and 9 copies (since one box already exists, the result will be 10 boxes).

Sequential Unit  
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This command allows you to set the Unit property of the selected objects in a consecutive manner. You may 
specify a Prefix as well as a Postfix to the numbering. The Start property defines the first number of the range. 
The Overlap property allows you to create series such as 1, 1, 2, 2, 3, 3 and the Gap property allows you to 
create series such as 1, 3, 5, 7. Notice that if you select objects manually one by one, this defines the order for 
the numbering. However, if you select them by dragging the mouse over the objects, the order of the objects 
undefined.

Sequential Circuit  

Sequential circuit essentially works just like sequential uniting – except that you assign circuit numbers to the 
Channel property of fixtures. You may specify a Prefix as well as a Postfix to the numbering.

Sequential Patch  

This command allows you to sequentially patch fixtures. The order in which you select the fixtures will be the 
order they are applied to the patch. You may choose the universe and start address by entering the address 
as Universe.Address. For example, entering 2.1 would have the fixtures start at channel 1 on universe 2. You 
also have the option of leaving a gap between fixtures if you wish.

Sequential Channel  

Sequential channel essentially works just like sequential uniting – except that you assign fixture numbers to 
the Channel property of fixtures. Since it is a number and not text, you are not allowed to specify a prefix or 
postfix.
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Model Import  

Using the Import Model Tool  

The Import Model feature is used to import models from other file formats as well as importing content from 
other project files. It opens these files in parallell and allows you to copy items into the project you are 
working with by using the arrow navigator button.

When opening older project files, a window may appear telling you that some fixtures have been updated 
since the project you are trying to import from. Its good practice to hit “Update” so the new project gets the 
same version of fixtures as in the current library.

When you drag object into your project you have the option of placing them where you put the mouse pointer 
or at their original position. Once you have finished, simply close the file you were importing from.

When importing models from other file formats attempts to preserve Drawing block name and Drawing name 
information. This information can later be useful when replacing imported objects with library fixtures, either 
manually or using the Import Data feature.

Supported Model File Formats  

Capture is able to import drawing information from other softwares using the file formats described below.

Autodesk DXF and DWG (.dxf and .dwg)  

The DXF format is a relatively simple text based format useful to transfer smaller models and drawings of 
simple nature. The more complex DWG format can contain more complex information such as solids and 
materials.

Both the DXF and DWG formats stand out in the fact that they do not enforce a model object hierarchy – a 
drawing could consist of loosely scattered polygons and lines only. As this is a problem for Capture, all 
drawing content that does not belong to a “block” will be grouped by layer, material and solids to single 
objects in Capture. In order for textures to import, the texture image file must located at either the same path 
as on the computer on which the DXF or DWG was saved, or in the same folder as the DXF or DWG file being 
imported.

Block defininition names are used as the Drawing block name, however the name of block definitions that 
only reference other blocks is also used as the Drawing name.

Cinema 4D (.c4d)  

This is the native format of Maxon’s Cinema 4D 3D package.

In order for Capture to be able to import model data from a C4D files it must either have been saved with the 
Cinema 4D preferences setting Files / Save Polygons for Melange set or using the Save Project for Melange.. 
function.

All objects in the scene graph are imported, but the tree as such is not preserved in any way. Only flat and 
UVW texture projections are supported.
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Object names are used as the Drawing name and the name of the object referenced by an instance object is 
used as the Drawing block name.

Cinema 4D Hantmade Stage Plugin Support  

When importing Cinema 4D files, Capture recognized Hantmade Stage fixtures and imports them as single 
objects. If a Capture fixture identity has been set a fixture’s Capture export settings, the fixture is 
automatically replaced with a fixture from Capture’s library.

Sketchup (.skp)  

This is the native format of Trimble’s Sketchup make and Sketchup Pro software packages.

While Sketchup supports double-sided materials Capture does not and will favor the front material over the 
back material. Capture will also preserve block and group transformations (useful for replace fixture 
operations) as long as no lines or surfaces in the group have been subject to mirroring.

Group and component names are used as the Drawing name and component definition names are used as 
the Drawing block name.

WaveFront (.obj)  

This file format was developed by Wavefront Technologies for its Advanced Visualizer animation package in 
the 1980s. It is a simple and text based, yet very competent file format.

As with the 3DS format, OBJ files do not have material textures embedded. Instead they are loosely packaged 
alongside the OBJ file, typically in a separate folder.

Group names are used as the Drawing name.

3D Studio (.3ds)  

This file format was the native format for the early versions of 3D Studio, a very popular 3D modeling 
software. It is rich in material settings and information required to produce very realistic models. Capture 
successfully handles most of the information in a 3DS file, however some of the more advanced material 
properties are not supported. 3DS textures are not embedded inside the 3DS file but loosely packaged, 
typically in a folder alongside the 3DS file itself. Be careful to take this into account when sending and 
receiving 3DS files! There is a rich amount of 3DS files available on the internet. However, many of these have 
been converted from other formats using automatic conversion tools of questionable quality.
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Fixtures  

Fixtures Overview  

Fixtures are handled in pretty much the same was as other objects. To add a fixture, it needs to be dragged 
from the library to one of the wireframe design views. Fixtures can be cloned, moved, rotated and deleted the 
same as any other object.

In this example, we add a single Mac 700 profile from the library. We then clone it so that we end up with one 
Mac 700 per meter of the truss.

Clone the Mac 700 Profile 11 times so the 12m truss has 1 Mac 700 every meter. The Mac 700’s will then span 
the truss equally.

Now that we have added the Mac 700’s. They need to be patched. There are two ways of patching fixtures in 
Capture. You can select the fixtures you wish to patch, in the order you want them patched, and from the red 
spanner (options) menu, you can select “Sequential Patch”. The sequential patch window will appear giving 
you the options of “Start Address”, which is formatted by double clicking the option and entering 
Universe.Address. For examples entering 2.1 would patch the fixtures to Universe 2, Address 1.
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The second option is to drag the fixtures to a start address within a universe window. First, open one of the 
project universes by clicking on the Edit button in the Universes tab of the Project Window. Then select the 
fixtures in the order you wish to patch them, click and hold the drag button and drag them to a start address 
in the open universe window.

DMX Universes  
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Once fixtures are patched onto Captures internal universes, you can link those internal universes to external 
universes that are coming into Capture via protocols like Art-Net or sACN. Very little user intervention is 
required with most of these protocols - Capture will accept most of them in a “Plug & Play” kind of manner.

Universes are managed in the Universes tab of the Project window. The left hand side shows the universes of 
your project and the right hand offers a preview of the selected universe. 

Capture automatically links external universes to internal universes, but also offers you the option of 
overriding the setup. To do this, double click on the External universe column property of a universe and 
choose the external universe you would rather use.

The Patch base property lets you choose the numerical location of a universe in relation to the other 
universes, independent of its name. 

In a theatrical environment it may be more convenient to work with a contiguous range of channel numbers 
(for instance 1 – 2048). This can be achieved by setting the Patch style property to Contiguous.

Fixture Settings  

All fixture settings are available in the Design tab of the Project Window, as illustrated on the right hand side. 
The settings are divided in several categories. It is possible to select multiple fixtures at once to change a 
setting for all selected fixtures simultaneously.

af://n255


Replacing Fixtures  

To replace fixtures in your design, first select the fixtures you wish to replace, then activate the replace mode 
using the Replace command, locate the fixture type you wish to use instead in the Library tab and finally 
drag it onto one of the selected fixtures.

This way all the selected fixtures are replaced for the new fixture type chosen. You can also drop the new 
fixture type onto any other fixture or replaceable object not selected, but this way you can only replace on 
fixture or object at a time.
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Adding Filters and Gobos  

Filters and gobos can be added to fixtures using drag and drop from the Library tab where a selection of 
filters and gobos is available.

If you wish to apply the same filter or gobo to more than one fixture at a time then select the fixtures first and 
then drag and drop the filter or gobo onto any of the selected fixtures. This will insert one in each of the 
fixtures selected.

Gobos and filters can be removed from fixtures using the Remove filters and Remove gobos commands.

Custom Gobos  

Custom gobos can be added in the Gobos category of the Design tab by clicking on the Add button. Once 
you have given the gobo a name you can choose an image for it. Use a square image, up to 256 by 256 pixels 
in size.

Finally drag and drop the gobo onto any fixture with a gobo slot to add it to the fixture. If you have selected 
multiple fixtures as you do this, the gobo will be added to all of them.

Customising Gobo and Color Wheels  

Changing Gobo/Color frames in intelligent fixtures is very easy, simply open the current wheel via the fixture 
properties, double clicking on one of the current color/gobo slots in the properties opens the wheel, then drag 
a new color or gobo from the library to a slot on the wheel and the fixture is automatically updated.

The Fixtures Tab  
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The Fixtures Tab is part of the Project Window and shows all fixtures in the show and subset of their settings. 
The Fixtures Tab can be navigated and edited as a spreadsheet using the arrow and Enter/Return keys. 
Multiple row selection is also possible using the Shift and Ctrl/Cmd keys and useful when dragging and 
dropping fixtures from the Fixtures Tab.

The Fixtures tab can be arranged in a number of ways. By default, the tab shows all fixtures currently in the 
project. It can be filtered by using the search function in the top right corner. It can also be filtered by clicking 
a column header to organize the data in ascending (or descending) order for that property. For example, in 
the image below, the window is filtered to show the source four fixtures ascending in patch data. The arrow in 
the Patch property column header denotes that the sheet is arranged showing patch data in ascending order. 
Clicking the Patch column header for a second time would toggle it into descending order.



Fixture Data Import and Export  

Using the Import Fixture Data Tool  

The Import Fixture Data tool can be found in the File menu and allows you to import a CSV text file containing 
fixture information which can be used either to add new fixtures to or update existing fixtures in your project.

CSV files are text files with information structured in a spreadsheet-like manner using (typically) commas as 
column dividers and linebreaks as row dividers. Because they are text files they can be opened and modified 
in text editors such as TextEdit or Notepad, but they are more typically produced an consumed by 
spreadsheet applications such as Numbers or Excel.

Capture attempts to configure itself automatically based on the headers Capture uses itself when using the 
Export Fixture Data tool, but also based on headers produced by other popular softwares. However, because 
ultimately any columns may be present in a CSV file it may be necessary to manually map some columns from 
the CSV file to Capture fixture properties. This is done in the File column mapping section.

In order for Capture to know whether to update an existing fixture or add a new fixture it is also necessary to 
select a property by which to uniquely identify fixtures. This is done with the Identify fixture by dropdown 
choice.

When Capture finds fixtures in the data file that do not exist in your project it can add new fixtures based on 
the information in the file. How to determine the type of fixture to add is decided by the column selected for 
the Fixture property of the New fixtures subsection.

Optionally, Capture can also replace imported objects in your project file with new fixtures. This behaviour is 
enabled by selecting a column for the Drawing name property of the New fixtures subsection. Capture then 
uses the Drawing name property of imported objects with the selected column of the data file to find 
matches. It is possible to choose whether the match needs to be exact or only partial using the Drawing name 
matching property.

VectorWorks Import Workflow  

It is possible to import a design from VectorWorks including both stage design / geometry model and fixtures. 
The workflow requires access to VectorWorks.

First export a DWG file from VectorWorks which will contain the stage model as well as the model of the 
fixtures. Then also export an “Instrument Data” file using the “All” setting which will contain all information 
about the fixtures in the DWG file such as their fixture type(s) and patch.

In Capture, first use the Model Import tool to import the DWG file. At this point you will see VectorWork’s 3D 
models of the fixtures and be able to select them, but not operate them as Capture does not yet understand 
that they are fixtures.

Finally use the Data Import tool to import the “Instrument Data” file previously exported. Once you have 
identified the fixture types of the file you will see the previously inanimate fixture models exchange for 
regular Capture fixtures, fully functional and with relevant information such as patch and notes transferred 
from VectorWorks.

Using the Export Fixture Data Tool  
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The Fixture Data Export tool in the File menu can be used to export CSV data files as well as grandMA 2 and 
Hog 4 XML patch files of the fixtures in the project and their associated data.

Exported CSV files can be opened in any text editors such as TextEdit or Notepad as well as spreadsheet 
software such as Numbers and Excel. Exported XML files can also inspected in text editors even though they 
are only intended to be imported in the grandMA 2 and Hog 4  consoles.

To export, go to the “File” menu, select “Export Fixture Data..” and specify the desired location and name of 
the exported file. Following this some exporting options are available as well as the ability to change the 
exported file format.

Exporting to grandMA 2  

When exporting to grandMA 2, a number of layer schemes are available:

Project layers creates one MA layer for each Capture project layer with exported fixtures.
Fixture types creates an MA layer for each type of fixture exported.
Single creates one MA layer which contains all fixtures exported.

On export a dialog is also shown where it is possible to specify the manufacturer, product name and fixture 
numbers of each fixture type exported. If left as is, the fixture types can be assigned in grandMA 2 after 
import, but if you wish to to avoid this step (and have already imported all required fixture types in your 
grandMA 2 show), then use these fields to set up the matching information.

Exporting to Hog 4  

On export to Hog 4 it is important for the exported file to contain the exact same manufacturer and product 
names as in the Hog 4 fixture library as otherwise fixture will be skipped on import.

On export an additional dialog is shown where you can adjust the manufacturer and product names exported 
for each fixture. Crosscheck these with the names of the fixtures available in your fixture library or use it to 
change fixture types on export, for instance in order to swap fixtures for desk channels.

Importing exported fixture data in grandMA 2 onPC  

First copy the exported MA 2 XML file to C:\ProgramData\MA Lighting 
Technologies\grandma\gma2_V_x.x.x\fixture_layers. Then, on the command line, enter the following commands, 
assuming the name of the exported file was exported_file.xml:

1. cd EditSetup
2. cd Layers
3. import exported_file.xml at 1
4. cd /
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Layers and Filters  

Using Layers  

Both layers and filters are managed in the Design tab of the Project window. Layers are useful to select and 
group many objects of a similar nature. Filters are essentially just groups of layers and universes. For example 
having a layer for “All Moving Lights”, “All Generics” and “All LED” could be useful. Then they could belong to 
the filter - “All Fixtures”. Layers and filters are very useful for managing project files with large amounts of 
objects & fixtures in.

Objects in a layer with the Locked property set cannot be modified. When the Include in reports property is 
unchecked, objects in that layer will not appear on reports. Live information and Fixture simulation can also 
be turned on and off on a per-layer basis in the same fashion. Filters are used to define sets of layers to be 
visible in design views and plots. They serve as layer filters and it is useful to note that you may work with 
different filters in different views if you wish.

When a design view is patched to a universe it is possible to choose the design view’s filter via DMX. However, 
this requires setting up the DMX control slot property of each layer that you wish to be able to choose. There 
are 64 slots available and they are identified with the numbers 1 through 64. A value of 0 means that it is not 
possible to select via DMX.

Adding fixtures or objects to a layer can be done in one of two ways, you may either drag the layer from 
the project window to the selected objects or you may select the objects and double click the “Layer” property 
in the properties and select the layer there. Adding fixtures to an existing layer is done in the same manner.

Using Filters  

As already discussed, filters are essentially just groups of layers and universes. As per our previous example, 
having a layer for “All Moving Lights”, “All Generics” and “All LED” could be useful. They could then belong to 
the filter - “All Fixtures”.

Adding filters is done in the same way as layers. Click on the Add button in the Filters category of the Design 
tab and name the filter. Once the filter has been created, in the right hand section of the window, a list will 
appear showing all the layers and universes. You can use the check boxes to control which layers and 
universes belong to the filter you created.
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Scenes  

Using Scenes  

Working with scenes allows you to modify the position and visibility of objects in different parts of a 
performance. If you wish to do this, it is important to set the Include in scenes property of the objects that 
wish to have dynamic positioning/visibility (this is important because many items such as the rig, truss and 
house will usually not be part of what can be moved during a show and keeping them out of scenes prevents 
you from making serious mistakes). Scenes are not stored or recalled – you are always working in one scene 
at a time and you can safely switch back and forth between scenes without risking loss of any position 
information. Scenes are most useful in a Theatre environment were you have one set of scenery for Act one 
and another set of scenery for Act two. By default there is already one scene in any project file - the “Default 
Scene”. To make more Scenes, right click on the scene node in the project window. Select “Add Scene” and 
name the scene accordingly.

Once you have made a second scene, we can proceed to make a scenery change. Add some scenery and 
position it as per your liking. Select all of the scenery, in the properties, locate the “Include in scenes” property 
and set it to “Yes”. Now double click your second scene (or right click on it and select “Go to scene”). Now we 
are in the second scene, move the scenery to a new location. Now switching between the two scenes moves 
the scenery between the two locations.
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Materials  

Using Materials  

Materials offer a way of applying a static image or video to an object. The best way to use a material is to 
think of it as an example of what your object is going to look like. They are useful to make objects appear as 
different things, for example mapping a picture of a bricks to a thin box, making it appear as a wall.

The library contains a selection of materials which can be applied to objects by dragging and dropping them 
from the library on to the object. To apply the same material to many objects, you can select the objects first 
and then drag and drop the material. The image and colour of the material is combined with the colour of the 
object that the material is applied to. Hence, if the object’s colour is set to black, the material will appear 
black.

You can create your own materials in the Design tab of the Project window, under the Materials category. You 
can then apply either an image from a file, a video on the local hard drive or streaming video source from a 
connected media server. To apply your own materials to objects, drag and drop them from the Materials 
branch rather than the Library tab.

In this example, we will look at using Materials to change the appearance of a thin box. First, make a new 
material in the project window.

In the material properties, available on the right when the material is selected, you may choose an image or 
video source. Double click on the image option and choose an image from the local hard drive. In this 
instance, the image will be a picture of some bricks. Once you have chosen the image, drag the material from 
the project window to the object you wish to map it to.

Mapping Materials  
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Once you have applied a material to an object, you may wish to map the material. Mapping a material 
consists of using the navigator to resize it, rotate it or fill the object space with the material, the latter is 
referred to as “Map to Extents”.

Moving and resizing the material with the navigator is done in the same manner as other objects. You may 
Map a material to multiple objects at the same time. Simply select all to the objects and drag the material to 
them, select the “Map Material” mode and map the material to your liking.

Material Properties  

The Color property defines the base color of the material. Capture utilizes the Physical Based Rendering (PBR) 
material model in which absolute white or black should normally be avoided.

The Texture image, Texture generator and Texture media choices are mutually exclusive and allow you to 
apply a texture to the material. This texture is combined with the base color and unless you wish to tint the 
texture with a color, the Color property is then best set to pure white.

Use the Texture Width and Texture Height properties to define the physical real-world dimensions of the 
image, generator or media texture applied. These dimensions define the size of the image regardless of the 
object it is applied to.

The Smoothness property defines how rough or smooth a surface is on a microscopic level. A material such 
as concrete would have a much lower smoothness value than for instance varnished wood.

The Metallic property allows you to mimic metallic looking finishes for metal items such as a car or steel 
beam. This should normally only be set to either 0% or 100%.

The Luminance property allows you to create materials that simulate light emitting surfaces such as flat 
screens or LED panels.
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Transparency allows you to set transparency for an object so to act like glass or gauze. This property works 
together with the Tint which determines whether items behind the object assume the colour of the object 
itself, as is the case with glass but not gauze. Finally Frost allows you to to give transparent objects a frosted 
effect.

Texture Generators  

Texture generators are a kind of crossover between media servers and static image textures. Texture 
generators produce a matrix image where the cell colours are controlled by DMX. This can be used for a 
number of effects, for example dimming a luminous object or simulating an RGB LED tape.

Texture generators support two DMX modes - Dimmer and RGB. In Dimmer mode each cell is coloured from 
black to white, based on a single DMX value. In RGB mode each cell’s colour is controlled by three DMX 
channels.

When patching a texture generator the number of channels required is determined by the DMX mode chosen 
and the number of rows and columns configured. Ie. a 3 by 3 matrix in RGB mode requires 3 x 3 x 3 = 27 
DMX channels.
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Media Fixtures  

Video Projectors and Digital Lights  

Capture supports a large library of Media Fixtures such as Video Projectors and Digital Lights. Adding a Media 
Fixture to a Capture Project is the same as anything else - drag it from the library into one of wireframe views.

With Projectors and Digital Lights, they need a video source for any output to be visible. Much like LED 
Screens, the video source may be an internal video player were by you choose a video file on the computer 
and play that. Alternatively you may also choose a video source from an external Media Server via CITP for the 
video source of a Projector.

In this instance we will just use a file on the computer and look at CITP sources in a later chapter.

Add a video projector to the project by dragging it from the library to one of the wireframe design views. You 
can select a non specific projector from the “Generic” section of Media Fixtures in the library. Add a box, and 
change its properties so that it looks like a video screen. Position the projector so it is pointing at the screen. A 
quick way to focus a projector (or any type of fixture) is to right click on the surface you wish to focus it on. In 
this case, its the screen on stage.

The projector will display a test image when it is turned on but not being assigned an image or media player.

Now, to play video from the projector, you can create a video player within capture. Simply, go to the Media 
tab in the Project window and press the Add button in the top right corner and name the video player 
“Projector Video”. Press the Add Video button and choose a video file from the local hard drive. You may 
select multiple videos as well as image files if you wish. Once you have selected the video you wish to play 
through the projector, press the play button next to it so the video is playing.

Finally select the video projector and access its properties in the Design tab. Double click on the Media 
property and choose the video player you had just created.
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Channel 1   Channel 2  

0-7 Pause 0-31 Playlist entry 1

8-15 Play 32-63 Playlist entry 2

16-23 Replay (Play again from the start) (similarly) (playlist entries 3 through 7)

24-31 Stop 248-255 Playlist entry 8

Video Players  

As discussed in the previous section, you can use an internal Video Player to play videos or images on Video 
Projectors in Capture. The Video Player can be controlled by DMX if desired. The Patch property of the Video 
Player can be access by clicking “Settings..” for the desired Video Player in the Media tab.

Using CITP Media Sources  

Capture supports connecting to Media Servers using the CITP communication protocol. This makes it possible 
to receive streaming video from a Media Server and apply it to objects like a material. You can view all 
connected Media Servers in the Video tab in the Project window.
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To apply a streaming video to an object, you must first create a material, select the desired video source, set 
up the dimensions of the material and then apply the material to the objects. Alternatively you may omit 
setting up the material dimensions and simply map the material using the material mapping functionality 
discussed earlier.

Little to zero configuration should be required with CITP. Ensure that the Capture machine and the Media 
Server are operating in the same range of IP addresses and subnet. If the Capture machine has multiple 
network adapters, it may be necessary to manually select the adapter you will be using for CITP information. 
This can be done in the Connectivity Tab of the Options menu.

Controller and Media Server Connectivity  
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  macOS Windows

Art-Net Yes Yes

Avolites ACDI   Yes

CITP Yes Yes

Compulite VC Yes Yes

EntTec DMX USB Pro Mk1 & Mk2 Yes Yes

ETC Net 2 Yes Yes

Green Hippo HMap 3 Yes Yes

High End Hog 3 & 4 Yes Yes

Kinesys K2 Yes Yes

LaserAnimation & Pangolin Yes Yes

MA Net 21   Yes

Streaming ACN Yes Yes

1 Requires MA software version 2.9. Requires manual activation; right click in the External 
universes list of the Universes tab to open the MA-Net configuration dialog.

NDI Video Sources  

Capture supports receiving video from NewTek NDI (http://www.newtek.com/ndi.html) video sources. This 
makes it possible to receive streaming video from a multitude of both software and hardware solutions. There 
are also some useful tools for desktop streaming and tests available from the NDI web page of NewTek. 
Capture lists all NDI sources it finds in the Video tab in the Project Window.

To apply streaming video to an object, follow the same procedure as with CITP Media Sources, described in 
the previous section.

No configuration is required for NDI, but it is possible to specify one or several NDI groups to limit NDI 
reception to in the Connectivity Tab of the Options menu. If the Capture machine has multiple network 
adapters, it may also be necessary to manually select the adapter you wish to use.

af://n455
http://www.newtek.com/ndi.html


LED Screens  

Using LED Screens  

Capture is not only capable of 3D rendering for Lighting Fixtures, but also a wide range of LED Screens too.

Adding an LED screen to a project, is the same as adding a fixture or object. LED Screens can be found under 
the Fixtures category of the library. Locate the particular model you require from the library and drag it into 
one of the wireframe design views. Use the clone function to clone the LED panel however many times is 
required to create the screen size you desire. Once You have added in an LED screen of the desired size. 
Mapping video to the screen is done with the use of Materials and Video Players.

Materials are images or videos you add to an object in capture. Video Players can either be an internal video 
player were by you choose a video file on the computer and play that. Or you may also choose a video source 
from an external Media Server via CITP for the video source of a material. In this instance we will just use a file 
on the computer and look at CITP sources in a later chapter.

Add an LED Panel to the project by dragging it from the library to one of the wireframe design views. Clone 
the panel so you have a suitable size of LED Screen. Your project should look similar to this.

Now, to play video on the LED Screen, you must make a video player within capture. Simply, go to the Media 
tab in the Project window and press the Add button in the top right corner and name the Video Player - 
“LED Screen Video”. Press the Add Video button and choose a video file from the local hard drive. You may 
select multiple videos if you wish. Once you have selected the video you wish to play on the screen, press the 
play button next to it so the video is playing. In the Design tab, select the Materials category and click the 
Add button.

Once you have created the material, you need to link the material to the video player. Do this by selecting the 
video player from the “Media” option within the material properties.

af://n459
af://n460


Once the Material has been assigned to the video player, drag the material from the project window to the 
LED Screen in one of the design views. Press the red spanner button and choose the “Map Material” option. 
Then select the “Map to extents” option, this will set the material to fill the whole screen.

The result will be the LED Screen receiving evenly mapped video across the array from the Video Player.



Plots and Paperwork  

Plots  

The plots functionality in Capture allows users to create paperwork of lighting plots featuring key information 
about the lighting rig. A plot can be viewed and edited in any design view that is orientated to the top view & 
plot mode, as shown below.

Plot Options  

Other than Fixture symbols, there are many other symbols that can appear on plots. The interactive image 
below shows examples of the available plot symbols. Symbols such as Sightlines, Fans, Fog Machines, Rigging 
Points etc may all be dragged into the project from the library just like other items. If you are unhappy with 
the default symbol for a fixture, you may drag a different symbol from the library to the selected fixture.
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Item Description

1 Optical information

2 Annotation

3 Focus information

4 Patch & circuit information

5 Colour filter information

6 Rigging point

Fixture Properties with Plots  

When fixtures are selected, there are some plot specific properties that are useful to know about.

Symbol will control which symbol is used on the plot for the selected fixture.

Symbol Usage will control which views the symbol actually appears in.

Direction snap is set to 30 degrees by default, this property controls the direction the fixture is facing on the 
plot.

Color by filer will set the fixture color to match the gel filter it has.
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Focus is the property that allows text to be placed in front of the fixture to indicate where that fixture is 
focused. Ie, drums.

Show Optics is the property that controls whether or not the plot displays the optical information of the 
fixture.

Show Wattage is the property that controls whether or not the plot displays the wattage information of the 
fixture.

Plot Styles  

With Capture Argo, there is now an option to create styles for use with specific plots later. There are multiple 
properties that can be included in a style, which can toggle on and off.

Exporting Plots  

Once a plot has been made in a paper design view, it can then be exported for print. To do this, create a new 
Plot by right clicking on “Plots” in the Project Window and clicking “New”. Multiple Plots can be added in this 
manner. Adding multiple plots to the same project file is very useful for creating tidy plots for only certain 
parts of a rig. Each Plot can be setup to show only certain layers based on the filter you select for the view.

Once you have added a plot in the Project Window. Double click on it to open it. The paper settings can be 
changed in “Page Setup”.

Right clicking on the plot will allow you to add a view to the plot as shown in the image below. You may also 
add Headers, Images, Text, Layer Keys and Symbol Keys in the same manner as adding a view.

Scale and move the plot to suit the paper.
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Motion Controllers  

Using DMX Motion Controllers  

Capture has the functionality to allow incoming DMX channels to be mapped to control the height and 
rotation of objects. In these examples, we are going to look at moving truss around with DMX. The 
functionality is not limited to trusses only, it can be used with most objects and forms within Capture.

There are two types of DMX Motion Controllers in Capture. The DMX Mover and the DMX Rotator.

The DMX Motion Controllers are added to a project like any other object in Capture - by dragging them from 
the Library into one of the design views. Its best to look at the controllers like lighting fixtures, they are 
fixtures in the project. Its good practice to place the movers near to the object they are controlling for ease of 
identification and manipulation, but they may be hidden from view if required.

The DMX Mover, pictured to the right, has two blobs at each end of the range. The thicker blob indicates the 
default starting point of the object the Mover is attached to. The thinner blob indicates the lowest point to 
Mover operates to.

The DMX Rotator, pictured to the right, is shown here as it is seen in the “Orthographic Front” design view. The 
thick blob in the middle of the circle indicates the central rotation point that the object will rotate around. The 
line protruding from the centre of the circle from the blob is the default starting point. The circle itself 
indicates the range in which the Rotator can operate. In this case, it is a full circle as the 
Rotator has a range of 360 degrees.

Adding a DMX Mover  

As we discussed, the first type of DMX Motion Controller is the DMX Mover.

The DMX Mover can move an object across a predefined range on the X Y Z axis. The mover can also be 
configured to operate on only one axis, for example Y, so that the object it is attached too will only move up 
and down.

Drag the DMX Mover into the project from the library. It can be found under “Motion Controllers”. Position it 
near to the truss it will be linked with, this will make it easier to manage projects with multiple movers.

Select the mover and access its properties in the Project Window.

Give the mover a name, using the “Unit” field. Then configure its properties to match the ranges in which you 
want to mover to operate. In this case, the X and Z range will be 0 and the Y range will be -5.8m as we only 
want the mover to move the truss up and down. 5.8m is the distance between the truss and the floor.

Select the Truss and the Fixtures you wish to move and select the DMX Mover from the “Motion Fixture” 
property in the Project Window.

The DMX Mover can now be selected and manipulated in the Live view just like any other fixture.

Adding a DMX Rotator  

The second DMX Motion Controller is the DMX Rotator. The Rotator can be used to rotate an object around 
on an axis and within a specific range on that axis.
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Now we add in a DMX Rotator and link the truss to it. We then go on to link the Rotator to the DMX Mover we 
created earlier. We call this “Chaining”. Once chained together it means that we can select both the Mover & 
Rotator and have individual control over both. The initial placement of the Rotator is of great importance. 
Wherever the Rotator is placed will be the point on which the rotation occurs. For example, we place the 
Rotator in the middle of the truss so that the truss Rotates around that point. Drag the DMX Rotator into the 
project from the library. It can be found under “Motion Controllers”.

Select the Truss and the Fixtures you wish to rotate and select the DMX Rotator from the “Motion Fixture” 
property in the Project Window.

Now, select the DMX Rotator and in the “Motion Fixture” property, assign the Rotator to the DMX Mover. This 
“Chains” the two motion controllers together so that when we select both, the truss can be moved up and 
down and rotated at the same time.

The DMX Mover & Rotator can now be selected and manipulated in the Live view just like any other fixtures.

Patching a DMX Motion Controller  

Because a DMX Motion Controller is treated just like a Fixture in Capture, it is patched in the same manner. 
You can manually enter its patch and mode data in the properties tab of the Project Window, or you may use 
the drag function to drag it onto the start channel of a particular universe. The patch property for the 
controller can be found under “Control” in the selected items section of the Design tab.

af://n538


Snapshots and Video Rendering  

Snapshots  

The still snapshots makes it possible to quickly move between key lighting looks while making design changes, 
even if no console is present. You can create high resolution renders at any point, watermarked with your logo 
and project information. Record movie snapshots including DMX, media and motion of parts of your show for 
offline playback. Export stand-alone 'Presentation' files that allow playback of all your snapshots while in an 
interactive environment - on any computer! Or if you prefer, render a high quality full-frame rate video file of 
your movie snapshots. To record a snapshot, simply press either the Record Still or Record Movie button in 
the snapshots tab of the Project Window. When recording a movie look, an extra dialog box will appear that 
allows you to set the FPS and start/stop. Snapshots can be played back by pressing the Play/Stop buttons the 
appear to the left of the Snapshot in the Snapshot tab.
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Standard Extended Function DMX Ranges Note

1 1 X Coarse -32768 to +32767 units (1)

2 2 X Fine    

3 3 Y Coarse -32768 to +32767 units (1)

4 4 Y Fine    

5 5 Z Coarse -32768 to +32767 units (1)

6 6 Z Fine    

7 7 Pan Coarse -180 to +180 degrees  

8 8 Pan Fine    

9 9 Tilt Coarse -180 to +180 degrees  

10 10 Tilt Fine    

11 11 Pitch Coarse -180 to +180 degrees  

12 12 Pitch Fine    

13 13 (unused)    

14 14 Ambient 0% to 100%  

15 15 Lighting 0% to 100%  

16 16 Atmosphere 0% to 100% (2)

  17 Filter

0 - 3, Layer Set 1 
4 - 7, Layer Set 2 
... 
248 - 251, Layer Set 63 
252 - 255, Layer Set 64

(3)

  18 Scene

0 - 3, Scene 1 
4 - 7, Scene 2 
... 
248 - 251, Scene 63 
252 - 255, Scene 64

(4)

Appendix A - DMX tables  

Cameras  

1. Units can be cm or dm, as configured by the user for the camera in Capture.
2. Unused since Capture Nexum.
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Standard Function DMX Ranges

1 Density Coarse 0% to 100%

2 Density Fine  

3 Variation Coarse 0% to 100%

4 Variation Fine  

16-bit XYZ Function DMX Ranges Note

1 X Coarse 0% to 100% (1)

2 X Fine    

3 Y Coarse 0% to 100% (1)

4 Y Fine    

5 Z Coarse 0% to 100% (1)

6 Z Fine    

8-bit XYZ Function DMX Ranges Note

1 X 0% to 100% (1)

2 Y 0% to 100% (1)

3 Z 0% to 100% (1)

16-bit X Function DMX Ranges Note

1 X Coarse 0% to 100% (1)

2 X Fine    

8-bit X Function DMX Ranges Note

1 X 0% to 100% (1)

3. Mapping of project layer sets to indexes is done by the user in Capture.
4. Mapping of project scenes to indexes is done by the user in Capture.

Smoke Boxes  

DMX Movers  
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16-bit Y Function DMX Ranges Note

1 Y Coarse 0% to 100% (1)

2 Y Fine    

8-bit Y Function DMX Ranges Note

1 Y 0% to 100% (1)

16-bit Z Function DMX Ranges Note

1 Z Coarse 0% to 100% (1)

2 Z Fine    

8-bit Z Function DMX Ranges Note

1 Z 0% to 100% (1)

Alpha 16-bit Function DMX Ranges Note

1 Alpha Coarse 0% to 100% (1)

2 Alpha Fine    

Alpha 8-bit Function DMX Ranges Note

1 Alpha 0% to 100% (1)

Alpha & Speed 16-bit Function DMX Ranges Note

1 Alpha Coarse 0% to 100% (1)

2 Alpha Fine    

3 Speed Coarse

0 - 2559, 0% to 100% 
2560 - 33791, Reverse continuous, fast to slow 
33792 - 34303, Standstill 
34304 – 65535, Forward continuous, slow to fast

(2)

4 Speed Fine    

1. Actual ranges are defined inside Capture in terms of meters or feet.

DMX Rotators  
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Alpha & Speed 8-bit Function DMX Ranges Note

1 Alpha 0% to 100% (1)

2 Speed

0 - 9, 0 to 100% 
10 - 131, Reverse continuous, fast to slow 
132 - 133, Standstill 
134 - 255, Forward continuous, slow to fast

(2)

1. Actual ranges are defined inside Capture in terms of meters or feet.
2. Actual range is defined inside Capture in terms of degrees.



Appendix B - Pan & Tilt Calibration Guide  
In order to help us correct the incorrect orientation of a moving head fixture as correctly and efficiently as 
possible, we may ask you to follow the following guide.

Before You Start  

Before you start the pan & tilt calibration procedure, please first make sure that in the settings of the fixture, 
no pan and/or tilt invert setting are active and that no overrides for its pan and/or tilt range are active. Also 
make sure that no pan and/or tilt settings are active in the DMX controller you are using during the 
calibration.

This guide assumes and requires that the fixture you are working with is positioned on the floor in front of 
you while observing it.

Position the Fixture  

Start with setting both pan and tilt to 50%. Position yourself or the fixture so that your shoulders are parallell 
with the yoke, as follows:

If at this point the display on the base of the fixture is facing away from you, either position yourself on the 
other side of the fixture or rotate the fixture 180 degrees (in either direction), as follows:
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Pan Calibration  

Question 1 – Now increase the pan parameter of the fixture from 50% towards 100%. Does the yoke rotate in 
a clockwise or anti-clockwise direction?

Example below: anti-clockwise rotation (left image) and clockwise rotation (right image) as follows.

Set the fixture's pan parameter to 50% again.

Question 2 – How many degrees would you need to rotate the base of the fixture so that its display faces you 
directly?
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Example below: +45 degrees (left image), 0 degrees (center image) and -45 degrees (right image).

Tilt Calibration  

Question 3 – Now increase the tilt parameter from 50% towards 100%. Does the aperture of the fixture move 
towards you or away from you?

Example below: the aperture moving towards (left image) and away from you (right image) as follows.
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